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Description 

This Statistical Process Control (SPC) Handbook introduces wood 

preservation industry personnel to the terminology and statistical process 

control (SPC) tools available for understanding and monitoring industrial 

processes. For those who want further information, references are provided 

at the end of each section.  The content is for educational purposes only. The 

use of trade or firm names in this publication is for reader information and 

does not imply endorsement by the United States Department of Agriculture 

(USDA) or The University of Tennessee of any product or service. 

This Handbook is organized as follows: 

§ Understanding variability and why we want to reduce it; 

§ Introducing important statistics; 

§ Tools for visualizing data; 

§ Understanding your process variability using control charts; 

§ Capability analyses; 

§ Root-cause analyses for reducing variation; 

§ Pareto principle; 

§ Appendices on statistical methods. 
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Know Your Enemy: Production Variability 

“Funny how we don’t have time to improve, but we have plenty of time to 

perform work inefficiently and to resolve the same problems over and over.” 

W. Edwards Deming 

Monitoring and Reducing Variation 

Reducing variation is the foundation for all Statistical Process Control (SPC) 

and continuous improvement philosophies, e.g., Total Quality Management, 

Six-Sigma Quality, Toyota Production System, Lean Six-Six Sigma, etc. 

Reducing variation in wood treatment is fundamental to long-term business 

profitability and meeting necessary treating targets. Less variation in the 

wood treatment process results in lower treating targets and reduced costs. 

Variation in manufacturing is cost 

There are many possible sources of variability in production of pressure-

treated wood. Understanding and reducing this variability requires a 

systematic approach. This handbook outlines a strategy for wood treating 

companies to apply SPC and other continuous improvement techniques to 

understand and reduce variation in the process of treating wood. 

Conformance to preservative penetration and retention standards is 

necessary for ensuring the long-term performance of pressure-treated 

wood. Accordingly, inspections of treatment quality by both the wood 
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treater and third-part inspectors are a critical component in the production 

process. Pressure-treaters currently produce material that passes these 

inspections for most charges. However, there is variability in both the 

treatment and inspection processes, and some charges fail inspections. 

Treatment companies can benefit by tracking variability, understanding the 

sources of treatment variability and, ultimately, minimizing the number of 

failing charges by reducing variability. 

Causes of Variability 

Wood Variability 

Perhaps the greatest source of treatment variability is the wood itself. Some 

of this variability is inherent to differences in a species’ microscopic anatomy 

and is difficult to predict or control. However, some of the other aspects of 

wood variability can be monitored and controlled by the treater: 

Moisture Content and Drying: Wood that has not been adequately 

dried (moisture content above 26 - 30%) does not treat as well or as 
uniformly as drier wood. Although wood is usually kiln or Boulton dried 
before treatment there may be substantial differences in moisture 
content between kiln charges and between pieces in a charge. There 

have also been reports that drying conditions (for example kiln 
temperature) can affect treatability, but other studies have not found 
a strong relationship. 

See AWPA T1-17, FPL GTR-190 or Maclean 1952 for additional 
information. 

Geographic source: In some cases, the geographic of a wood species 

has been found to be influenced by the area where it was grown. The 

age and growth rate of trees can also vary substantially between 
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locations. If treaters are aware of the regions from where the wood 
products are sourced then there is potential for reducing variability by 
grouping commodities of similar treatability into the same charge. 

Treatment Process Variability 

Wood Dimensions: Within charge treatment variability may be 

increased if pieces of substantially differing dimensions, sawing 
patterns, or log dimensions are treated in the same charge. The 

thickness and width of lumber and timbers affects where they are cut 
from a log, grain orientation, and heartwood content. 

*Refer to Maclean 1952 

Charge Conditions: The intensity and duration of preservative 
treatment of the initial vacuum and subsequent pressure periods affect 
both penetration and retention, and these parameters are set by the 

treating plant operator. However, other aspects of the treatment 
process such as time to fill the cylinder, time to reach maximum 

pressure, and time to release pressure may not be directly controlled 
and can also affect treatment quality, especially with short treatment 
cycles. 

*Refer to Maclean 1952, FPL GTR-190 for more info. 

Treating Solution: The concentration of actives in the treating solution 

directly affects retention and is measured and controlled by plant 
personnel. However, errors in the measurement of solution 

concentration or inadequate mixing has potential to affect charge 

retention. Other characteristics of the solution such as temperature, 
cleanliness of solution, and stability can also affect quality of 
treatment. 

*See AWPA A standards for appropriate analytical method for a given 
preservative system and refer to AWPA P standards for standardized 
methods of application and approved retentions for a given 
preservative system. 
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Equipment Reliability: Equipment malfunction or error can cause 
dramatic obvious impacts on a charge or more subtle affects that 
might be more difficult to detect. 

*In general, refer to AWPA M- standards as a reference for proper 
maintenance and required instrumentation for pressure treating 
equipment.  

Inspection Process: The inspection process has variability, the greatest 
of which is a result of wood variability. Because of this wood 
variability, the retention of preservative within a charge varies 
between and even within each product. As an example, 20 increment 
cores removed from a charge may only represent a tiny fraction in 
some cases (e.g., with exception of small batches of poles) of the wood 
volume in that charge, and thus may provide only an estimate of 
charge retention. An additional set of 20 cores if/when available may 
provide a somewhat different estimate of retention. Much of this 
variability is inherent to wood properties and difficult to control, but 
some geographic factors such as uniform drying, grouping of material 
from a single source, and grouping of pieces of similar dimensions, can 
help to lessen within charge variability. There is also variability 
associated with the instrumental analysis of the wood sample. Even a 
well-calibrated instrument has some variability associated with 
measuring preservative concentration, but this variability can be 
greater if the instrument is not working properly. 

*See AWPA M25-17 for additional information on Standards for 
Quality Control of treated products for residential and commercial use. 
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Turning Data into Knowledge with Statistics 

“The goal is to turn data into information, and information into insight” 
Carly Fiorina 

Statistics that Measure the Central Tendency of Data 

Statistics helps us transform data into knowledge. For example, the 

‘average’ is a statistic that everyone sees almost daily in weather reports, 

economic reports, sports news, and other common information.  The  

average is a ‘location’ statistic and is the ‘center of gravity’ of the data set. 

Even though the average helps us gain some knowledge, it is subject to 

influence from extreme values in the data. For example, economists report 

the ‘median’ household income because if a billionaire’s income was 

included in the average income statistic, it could greatly skew the average 

and be a false indicator of the wealth depending on the size of the 

population. 

The average is typically called the “Arithmetic Average,” “Sample 

Mean,” “X-bar,” or !"# and is calculated by summing the data and dividing 

by the number of data points in the data set. For manufacturing processes, 

it is sometimes referred to as the “Process Center line (PCL).” It is calculated 

for the example below for n = 5 samples, as the sum of the samples divided 

by n. 

9.2 + 6.4 + 10.5 + 8.1 + 7.8 42.0 
$ = = = 8.4 

5 5 

The “Median (M)” of a set of n measurements is the middle value (or 

“midpoint,” “50th percentile”) where the data are ordered from smallest to 

8 



Figure 1. Trend chart of retention of charge over time with an average and median. 
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largest. If n is an odd number, there is a unique middle value and it is the 

median. If n is an even number, there are two middle values and the median 

is typically defined as their average. M = 8.1 for the sample of n = 5 ordered 

example data below. 

Example: 6.4 7.8 8.1 9.2 10.5 

What is the average and median of: 1, 2, 3, 4, 5? "1 = 3 ; M = 3 

What is the average and median of: 1, 2, 3, 4, 100? "1 = 22 ; M = 3 

Retention data is typically plotted as a time series and the average and 

median can be of help in assessing trends and stability over time. Here we’ve 

plotted a hypothetical example of the retention of charges over time with 

the average and median (Figure 1). 

Figure 1. Trend chart of retention of charge over time with an average and median. 
 

 

Variable Mean Median 

Charge Retention 0.06736 0.06505 
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Statistics that Measure the Variability of Data 

Statistics are helpful in helping us understand the variability in a set of data. 

For example, the figure above shows how individual charge retentions may 

vary around the average over time, assuming consistent inputs and 

processing parameters. Common measures of variability in statistical process 

control include the range, variance, and standard deviation. The Range (or 

R) is useful for estimating dispersion in small data sets, it is the largest value 

minus the smallest value. 

Example: 6.3, 2.4, 3.1, 3.1, 5.8, 2.7, 8.1;  R = 8.1 – 2.4 = 5.7 

The sample variance (s2) also measures dispersion and is calculated as: 

∑9?@(89:8̅)
= 

45 = 
> 

≈ D5 (EFEGHIJKFL MINKILOP) 
A:B 

The sample standard deviation (s) is: 

V∑ (xT − x1)5 
TWB s = R ≈ D (EFEGHIJKFL 4JILYINY YPMKIJKFL) 
n − 1 

‘s’ estimates variability in same unit of measure as the sample mean 

The aforementioned statistics help describe the data and are called 

‘descriptive statistics’ (more detail is given in Appendix A-Descriptive 

Statistics). In Statistical Process Control (SPC), we use these statistics to help 

us quantify the natural variation (or ‘common-cause’ variation) of a process. 

The control chart is a key tool in SPC and distinguishes two types of variation 

‘natural variation’ from ‘special-cause variation.’ Special-cause variation are 

‘events’ that occur in the process, e.g., sensor failure, flow meter failure, 

plugging, leakage, etc. 
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Visualizing Data 

“Without data you’re just another person with an opinion” 
W. Edwards Deming 

Histograms 

The histogram is a frequency distribution (or specialized bar chart) that 

shows how often each different value occurs. Sometimes the frequency bins 

in histograms will be divided by a total to give percentage or fractional 

representations. A histogram is a tool to see the general shape of the data. 

The following is an example of constructing a "Stem-and-Leaf" histogram. 

The following data (n = 24 observations) was observed: 

87.7 88.3 89.4 90.2 95.0 95.0 95.0 91.9 92.1 92.1 92.5 92.0 90.8 90.8 

90.3 90.8 90.2 90.9 90.9 90.1 89.5 93.2 94.9 93.0 

Create a scale from the smallest to the largest number by integers (whole 

numbers) and place the decimal associated with the integer next to each 

integer: 

87 
88 
89 
90 
91 
92 
93 
94 
95 

7 
3 
4  5 
2  8  8  3  8  2  9  9  1 
9 
0  1  1  5 
2  0 
9 
0  0  0 

The ‘Stem-and-Leaf’ plot is a simple form of a histogram. Histograms can 

also be easily generated in ExcelÒ and most statistical software. 

11 



         

     

       

        

          

           

 

 
 

 

   

       

               

      

          

          

        

   

 

Figure 2 is another example of a histogram from the wood industry but not 

retention, where only sample measurements of conforming data were 

recorded (truncated data). In the histogram below, the statistical software 

that developed the histogram tries to fit a normal or bell-shaped curve to the 

data. As shown, there should be data below the lower specification. The 

histogram is a simple but highly effective tool for visualizing data and 

identifying issues related to the quality of the data. 

Figure 2.  Histogram with truncated data ending at the lower specification limit (LSL). 

There can be multiple reasons for the truncation, including re-

treatment of charges that are initially below the lower specification limit 

(LSL) or discarding of charges that fall below the LSL. It may be an indicator 

that further data quality should be explored, including maintaining below 

specification limit values to better characterize the actual process. The curve 

overlay is a normal distribution assuming the same mean and variance as the 

observed data. The normal distribution curve is symmetric about the mean, 

while the observed data are asymmetric. 
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Scatter Plots 

XY scatter plots graphically relate two sets of data. Such plots can be used 

to assess if one measurement variable is ‘correlated’ to another 

measurement variable made on the same sample. Each data point in the 

plot has an X value and a Y value. For example, suppose we’re interested in 

whether mens’ height and weight are related. If there is a sample of 50 

observations of mens’ weight and height, each observation can be plotted in 

the XY scatter plot to visualize the relationship.  

Figure 3.  XY scatter plot of males’ height and weight (n = 50). 

Figure 3 shows us that there is a positive, linear relationship between these 

men’s height and weight in this population: As men get taller, they generally 

weigh more. XY scatter plots are often used to assess the calibration curve 

for measurement equipment or on-line sensors. 

13 



   

      

      

          

        

     

 
 

 

       

        

       

          

 

 
 

 
 

 

   

For example, treated wood standards with known preservative 

concentrations can be analyzed in an XRF spectrometer (e.g., ASOMA, 

Oxford, Rigaku units) to help to make sure they are working correctly. In the 

figure 4 below, the XY scatter plot shows a consistent, positive and linear 

relationship between the copper in a series of treated wood standards and 

the output from the XRF spectrometer. 
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Figure 4.  XY scatter plot for calibration data for an XRF analyzer. 

Not all relationships shown in XY scatterplots will be so clear, and may be 

either negative and/or non-linear. The relationship may be strong, weak or 

non-existent. All of these trends can be seen in an XY scatterplot, which is a 

powerful tool. XY scatter plots can be easily created in ExcelÒ and other 

software packages. 
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Figure 5.  XY scatter plot of wood moisture content versus solution uptake illustrating 
a weak, negative correlation. 

 

 
 

 
 

            
 

 

 
  

 

Figure 6.  XY scatter plot of wood density versus solution uptake illustrating a strong 
negative correlation. 

For a more detailed review of histograms and XY scatter plots, see the helpful 
links, 

https://www.moresteam.com/toolbox/histogram.cfm , 
https://www.khanacademy.org/math/ap-statistics/quantitative-data-

ap/histograms-stem-leaf/v/histograms-intro , 
https://www.mathsisfun.com/data/scatter-xy-plots.html . 
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Control Charts - Understanding Natural Variation 

“You cannot manage or improve what you cannot measure” 
Armand V. Feigenbaum 

The control char t is the core tool of SPC and is the first step in quantifying 

the normal variation that is part of your operation. The control chart is a vital 

tool for ensuring that operational treatment targets can be maintained and 

determines where continuous improvement efforts have reduced variation. 

There is variation in any wood treating operation. The first step in any 

quality improvement effort is to measure and monitor this variation. A main 

concept in SPC is that, for any measurable process characteristic, causes of 

variation can be separated into two classes: 

1. Natural (common, or chance) causes of variation, e.g., 

§ lumber, 

§ chemical, 

§ pressure, 

§ new product setup, etc. 

2. Special (assignable or ‘events’) causes of variation, e.g., 

§ part failure, 

§ machine stop, 

§ shift change, 

§ float valve stuck, 

§ over-adjustment of set-point, 

§ Monday-morning, etc. 
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The ‘Shewhart’ Control Chart is used to distinguish between special-

cause and natural variation.  It is used to assess sources of variation in the 

process (see Figure 7). 

Figure 7. Illustration of Shewhart control chart and statistical foundations. 

Controls charts are developed by recording the values of a production 

parameter over time. In a wood treatment operation, this could be charge 

retention values. Upper and lower control limits of approximately ± 3 

standard deviations on each side of the average are calculated from the data.  

The control limits contain 99.7% of the data from the system and cover the 

range of expected values for the process during the result of normal 

operations. The control chart assumes that the data come from a normal 

(bell-shaped or Gaussian) distribution. An example of a control chart for 

retention values that are almost in control is illustrated in Figure 8. The 

minimum retention of the preservative is 1.00, and the average retention of 

the charge is 1.26. The upper and lower control limits are 1.59 and 0.94, 

respectively. The differences in charge retentions between those values are 
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caused by natural variation in the process. The retention of one charge 

exceeds the upper control limit (red box #1) and is assumed to be a result a 

special cause variation, where something special happened to cause this to 

go over the limit value. This requires investigation! You might discover that 

a metering valve on the concentrate tank was broken, resulting in an overly-

concentrated treating solution. 
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0.9 
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Observation 

Figure 8.  A control chart for retention values with special-cause variation (red box 1 is 
out of control, red box 2 is a run of seven points above the center line). 

Depending on the parameter, other forms of control charts may be 

useful, such as the difference control chart described below or moving range 

charts discussed in Appendix A. Popular software packages for control 

charting with other quality control tools are JMPÒ (www.jmp.com) and 

MinitabÒ (www.minitab.com). Control charts can also be developed 

manually in ExcelÒ or other types of spreadsheets. See Appendix A for a list 

of the formulas and more detail on control charting. 
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Run Tests for Control Charts 

Sometimes there will be out of control patterns in a control chart, even when 

the data points are within the control limits. For example, the 6 values before 

the red box #2 in Figure 8 are all above the mean value. This run of above 

average values is very unlikely to occur simply by chance and thus this event 

deserves further exploration, just like the out-of-control event at red box #1. 

The statistical basis of the run tests or rules is simply that if the data are truly 

from the normal distribution, then there will not be any pattern to the points. 

Common run rules for detecting abnormal patterns in control include charts 

include: 

§ Run Test 1: a point more than three standard deviations (LCL and 
UCL) from the average is an indication that the process is out of 
control. 

§ Run Test 2: 7 or more consecutive points same side of average is 
an indication that the process mean has shifted (Nelson). 

§ Run Test 3: 6 consecutive points increasing or decreasing is an 
indication that the process mean has shifted (a trend) (Nelson). 

A complete listing of the eight run rules with detailed explanations can be 

found at, http://www.smartspc.com/blog/tag/spc-trend-rules/ . 

Difference Control Chart 

The difference control chart is an extension of the control chart concept. It 

is an excellent tool to monitor process stability that quantifies all of the 

variation (common- and special-cause) of the difference between two 

numbers: e.g., the actual measurement and the target. 

19 
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Consider having the following control chart (Figure 9), but we have 

now added a line for our target retention. To construct a difference chart 

from the data in the top chart, we construct a chart that looks similar but 

instead plots each observed value minus another value, such as the target 

retention level. The LCL and UCL are then determined as appropriate from 

those differences. The new target becomes zero, while the average value 

represents the average difference relative to the target, giving average over-

or under-retention (Figure 9, bottom). 

Figure 9. Control chart showing observed retentions relative to a target (top).  
Difference chart (bottom) plotting differences in retention from the target with 
shifted control limits. 

The control chart shown in Figure 10 highlights the variation in the 

differences between individual charge assay retentions and the retention 

target value. Most of the data points are negative and the average difference 

is negative because in most cases the charge assay retention is slightly less 

20 



        

         

  

  
 

          
         

 
       

     
 

            
           

 
    

        

than the target retention. Notice the out-control signals identifying events 

or special-cause variation. They indicate charges where the wood was 

substantially under-treated. 

 
   

  
 

      

Re
te

nti
on

 - 
Ta

rg
et

 R
et

en
tio

n 

Individuals Chart of ‘Observed Retention – Target Retention’ 

Figure 10.  Control chart of differences between observed retention minus target 
retention highlighting out of control points as red boxes. 

Suggested References for Control Charts 

Deming, W.E. 1986. Out of the crisis. Massachusetts Institute of 
Technology, Center for Advanced Engineering Study. Cambridge, MA. 

Montgomery, D.C. 2013. Statistical quality control: A modern introduction. 
John Wiley & Sons, Inc. 752p. 

Shewhart, W.A. 1931. Economic control of quality of manufactured product. 
D. Van Nostrand Company. New York, NY. 501p. 

Young, T.M. 2008. Reducing variation, the role of statistical process control 
in advancing product quality. Engineered Wood Journal. 11(2):41-42.   
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 LSL 

Figure 11.  Histogram of retention with descriptive statistics. 

Capability Analyses 

“Where there is no standard there can be no Kaizen (Improvement)” 
Taiichi Ohno 

Your company must determine if the treated wood products can meet a 

customer's standards. Typically, there is some lower limit that the tested 

product must exceed. In other cases, there can be both a lower and upper 

limit. Customers, regulating agencies, or engineers usually set these 

specifications. The specification limit(s) is called the engineering tolerance, 

or ET. In the example in Figure 11 there is only one limit for retention value, 

a lower specification limit (LSL). 

As described in the previous section, there is a natural variation in any 

manufacturing process (the mean ± 3 standard deviations). This is also called 

the natural tolerance of the process, or NT. Comparing the natural variation 

of your product (e.g., retention value) to specification limits is a called a 

‘capability analysis.’ 
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Natural Tolerance (NT) = 6 ´ s 

Engineering Tolerance (ET) = USL – LSL 

Capability and Performance Indicators approximate ET/NT 

Capability analyses typically include a histogram of the process values. A 

histogram shows the probability and relative frequency of values over the 

range. Individual data points are put into groups, and the groups (shown as 

bars) with the height of the bar corresponding to how many points are in 

that group. Figure 12 shows a histogram of charge retention data. For the 

280 charges tested, the average (mean) value was 0.067, and most of the 

charges were close to that value. Notice the fit of the bell-shaped curve 

which is typical of a normal distribution for many datasets. 

For a capability analysis, the specifications are often overlaid on the 

histogram, to show the relationship of the NT to the ET.  In Figure 12 most of 

the data (in this case charge retention values) are above the target; however, 

due to the natural tolerance of the process, there are some charges that are 

out of specification. It is important in a capability analysis that the natural 

tolerance of the process is in a state of statistical control, i.e., there are no 

out of control points, see Figure 12 below (the LSL, Target and USL are 

theoretical for the sake of example). 
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Figure 12. Histogram with theoretical specification limits and control chart illustrating 
state of statistical control of the data. 

Capability analyses summarize process information by indicating how 

the natural process variation conforms or doesn’t conform to the 

specification limits of the process. While a specification limit can be 

arbitrarily set at a given value, the natural variation of any process means 

that the target production value cannot simply be set at the specification 

limit. The target for production must include allowance for the natural 

variation that will occur. As the process becomes better understood, and the 
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causes of variability identified and controlled, then the target can be shifted 

closer to the specification limits. 

Suggested References for Capability Analysis 

ASTM E2281. 2015. Standard practice for process and measurement 
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Bothe, D.R. 2001. Measuring process capability. Landmark. Publishing, 
Cedarburg, WI. ISBN 0-07-006652-3 

Graham J. and M. Cleary.  2000.  Practical tools for continuous 
improvement, Vol. 2: Problem-Solving and Planning Tools. PQ Systems. 
Dayton, OH.  ISBN-10: 1882683064 

Pyzdek, T. 2003. Quality engineering handbook. Taylor and Francis. New 
York, NY. ISBN 0-8247-4614-7. 

Rodriguez, R.N. 1992. Recent developments in process capability analysis. 
Journal of Quality Technology. 24(4):176-187. 
DOI:10.1080/00224065.1992.11979399 
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Root-Cause Analyses for Reducing Variation 

“Ask ‘Why?’ five times about every matter” 
Taiichi Ohno 

Root-cause analysis focuses on identifying and understanding the potential 

factors that contribute to production problems. In a wood treating 

operation, such a problem could be inconsistent penetration or too many 

nonconforming charges. Root-cause analysis is typically done after an event 

has occurred with the goal being to improve process understanding by 

developing solutions to eliminate problems from reoccurring. To be 

effective, root-cause analysis should be performed as part of an 

investigation, usually as a team effort. Root-cause analysis should also be 

forward-looking, aiming to reduce the future occurrence of problems and 

not to cast blame on an operator. 

“Fishbone” or Ishikawa Diagrams 

Ishikawa first used a fishbone in the 1960s in the Japanese automotive 

industry (Ishikawa 1968). The idea of the Ishikawa diagram is that important 

sources of variation are categorized into five groups (see diagram below). 

People Machines Methods 

Variation 

Measurement Materials 

Problem 

     

    
                                                                                                    

 
       

      

        

          

        

       

       

        

         

    

   

     

             

 

 

  

 

26 



 

          

  
       

  
     

      
       

        
           
    

 
      

      

         
      

 
      

         

    

    

 

 

  

 

  

   
 

  

 
  

 

 

Ishikawa (1968) has some helpful points on how to construct the diagram: 

1. Place the main problem under investigation in a box on the right. 
2. Have the team identify and clarify all the potential causes of the 

problem whether small or large (process variables). 
3. Sort the process variables into naturally related groups. These groups 

become the major bones on the Ishikawa diagram. 
4. Combine each bone in turn, if the combined process variables are 

specific, measurable and controllable. If they are not, branch or 
explode the process variables until the ends of the branches are 

specific, measurable, and controllable. 
Tips: 

ú Take care to identify causes rather than symptoms. 

ú Post diagrams to stimulate thinking from other staff. 

ú Ensure that the ideas placed on the Ishikawa diagram are process 
variables, not special causes, tampering, etc. 

In a treating plant example situation, the frequent need to retreat charges 

could be considered a problem. A fishbone exercise could be a useful 

organized brainstorming technique to help to understand the causes of 

needing to retreat (Figure 13). 

Figure 13.  Fish-bone or Ishikawa diagram of charges. 

Retreats 
Too Many 

Measurements 

Methods 

Material 

Machines 

Personnel 

sampling 
Not following protocol 

Insufficient vacuum 

high 
Wood moisture to 

product 
assay zone for new 
explained sampling 
Protocol not clearly 
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XRF machine not 

Cause-and-Effect Diagram 

rated correctly 
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An advantage of the fishbone process, is that it can draw on input from 

various people throughout the plant/mill. Each person in the mill has their 

own perspective and special knowledge, and the fishbone helps to draw 

these sources of knowledge together. 

The ‘5 Whys’ - Lean Root Cause 

By repeatedly asking the question “Why?” (five times is a good rule of thumb 

but not always root to get to the root cause), you can peel away the layers of 

symptoms which can lead to the root cause of a problem. 

Ohno (1988) gave the following example for a problem identified as 

the “Machine stopped functioning:” 

1. Why did the machine stop? 

There was an overload and the fuse blew. 

2. Why was there an overload? 

The bearing was not sufficiently lubricated. 

3. Why was it not lubricated sufficiently? 

The lubrication pump was not pumping sufficiently. 

4. Why was it not pumping sufficiently? 

The shaft of the pump was worn and rattling. 

5. Why was the shaft worn out? 

There was no strainer attached and metal scrap got in. 

If this problem solving procedure was not carried through, one might simply 

replace the fuse or the pump shaft. In that case, you would expect that the 

problem would recur because the root cause was not addressed. The 
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symptom was addressed, but not the root cause. In the fishbone example 

shown previously, insufficient initial vacuum was identified as a cause of 

needing to retreat. But what caused the insufficient vacuum? This is an 

opportunity to ask ‘Why?’ in a systematic, repeated way to address this 

problem (Figure 13). 

Cause Mapping 

Cause Mapping expands on some of the basic ideas of lean root cause, the 

fishbone diagram and the ‘5 whys’. At every point in the Cause Map, 

investigators ask ‘why’ questions that move backward through time, 

studying effects and finding their causes.  

Cause Maps Tie Problems to an Organization's Overall Goals 

As Ishikawa (1968) illustrated, the fishbone better defines one problem by 

identifying potential causes. Cause Mapping involves pursuing the causes, 

asking “why?” repeatedly to identify root causes and determining potential 

solutions. 

GOAL 

IMPACTED 
Because Because Because Why? Why? Why? 

            

         

          

        

   

  

             

      

      

  

  

        

    

      

 

 

   

          

     

         

 

 

 
      

Assume that the plant has experienced several treatment charges failing that 

had assay retention levels. The goal impacted by charges failing would be 

treatment quality. Two possible initial reasons for failing charges could be a 

treating solution that had too low of a strength or that was a mistake in the 
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retention measurement. Following possible causes repeatedly leads to 

potential initial causes and to some potential solutions (Figure 14). 

Figure 14. Cause map of reasons for charges failing assay retention specification. 

Suggested References for Root Cause Analysis 

Deming, W.E.  1986.  Out of the crisis.  Massachusetts Institute of 
Technology, Center for Advanced Engineering Study. Cambridge, MA. 

Gano, D.L. 2007. Apollo root cause analysis: a new way of thinking. 
Apollonian Publications.  Richland, WA. 

Ishikawa, K. 1968. Guide to Quality Control. Asian Productivity 
Organization. Tokyo. 

Ohno, T. 1988. Toyota production system: beyond large-scale production. 
Productivity Press. Portland, OR. ISBN 0-915299-14-3. 

Rooney, J.J. and Vanden Heuvel, L.N. 2004. Root cause analysis for 
beginners. Quality Progress. 37(7)45-53. 
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Pareto Principle – “The Pareto Chart” 

“For many events, roughly 80% of the effects come from 20% of the causes” 
Vilfredo Pareto 

Sutton (2014) documents the history of the Pareto Chart and the 80/20 

principle, “In the late nineteenth century the Italian economist and 

misanthrope Vilfredo Pareto famously noted that most of the wealth in any 

community was held by a small proportion of the population. From this 

insight he developed the 80/20 rule, or the Pareto Principle, which, in the case 

of community wealth, meant that about 20% of any population owns about 

80% of the wealth. His principle, which has no theoretical underpinning, is 

widely observed to be true in many fields of human activity, including risk 

analysis.” 

Of course in many cases the actual proportions might not be exactly 

80% and 20%. But the point is that an ‘important few’ or the ‘vital few’ have 

a great impact on the business, whereas the ‘unimportant many’ are much 

less significant. For example, a safety manager is likely to be more effective 

by directing his or her program toward the few individuals that are causing 

the most incidents. Spending time on the ‘unimportant many’ is not likely to 

have much benefit. 

“Pareto Principle – Reliability Example” 

Sutton (2014) has a very good Pareto principle example as related to an 

electrically-driven pump that has a probability of failure to start of 0.1, 

meaning it will not start one times in ten. Management has decided that this 
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failure rate is too high; they wish to reduce the rate to lower than 0.02, i.e., 

one time in fifty. As Sutton (2014) notes, a survey of plant records for this 

and similar pumps is made. The following reasons for a pump of this type 

failing to immediately start are identified: 

ú Operator busy elsewhere, 
ú Electrical power not available, 
ú Start switch does not work properly, 
ú P-101B motor fails, 
ú Discharge valve sticks close, and 

ú Operator starts the wrong pump. 

The number of occurrences for each of the six failure types are listed below. 

The events are sorted by failure frequency and given an importance ranking. 

Table 1. Reasons for pump failure 

Reasons for Failure 
Number of 
Incidents % of Total Cumulative % Rank 

Operator busy elsewhere 123 60.6 60.6 1 
Electric power not available 44 21.7 82.3 2 

Motor fails 18 8.9 91.2 3 
Operator starts the wrong pump 12 5.9 97.1 4 

Start switch does not work 5 2.4 99.5 5 
Discharge valve sticks closed 1 0.5 100.0 6 

Totals: 203 100.0 

Cumulative Failure Rate 

The data in Table 1 above show that the items ‘Operator busy elsewhere’ and 

‘Electrical power not available’ contributes 82.3% toward the overall failure 

rate. In terms of the Pareto Principle, these two items are the ‘important 

few,’ with the others being the ‘unimportant many.’ 

Therefore, to improve the system reliability, all efforts should be 

directed toward ensuring that the operator has sufficient time to start the 
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spare pump, see the Pareto chart of this data in Figure 15. If this failure mode 

can be removed from the system, the system reliability will increase by 60%. 

If the second ranked item, ‘Electrical Power Not Available’ can be eliminated 

also, system reliability will improve by more than 80%. 

Figure 15. Pareto chart of incidents for pump failing to start. 

The logic of the Pareto principle can be applied to a treating plant’s 

operation. It can be used for any problem that occurs repeatedly and has 

multiple causes. It makes sense for the improvement process selected since 

it focuses on those few causes that occur most frequently. Because it is 

usually not possible to fix every potential problem-causing situation, the 

most efficient path to improvement focuses on the most commonly 

occurring failure modes. 
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Suggested References for the Pareto Principle 
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Pareto, V. 2005. Pareto optimality. Oxford University Press. Oxford, UK. 
ISBN-13: 9780199264797. 

Sutton, I. 2014. Process risk and reliability management. Elsevier. 
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APPENDIX A – Descriptive Statistics 

Statistics that Estimate the Central Tendency of the Distribution of the Data 

     
 

  

 

  
 

    
   

 
  

 

     
 

     
      

 

	 	 	 	  

 
   

 

 

Process Center Line (PCL) is typically the “Arithmetic Average,” 
“Arithmetic Mean,” or “Sample Mean”: 

§ Average or Sample Mean is the "center of gravity of the 
data set" !"# 

§ Average in Statistical Process Control (SPC) is stated as "X-
bar" 

§ If you have n observations, x1, x2, …, xn, then the formula 
for the Average or Sample Mean (“Arithmetic Mean”) is 

A∑ Z[\WB Z = ≈ ] (EFEGHIJKFL ^PIL) 
L 

• Example with n = 5 observations: 

9.2 + 6.4 + 10.5 + 8.1 + 7.8 42.0
$ = = = 8.4

5 5 
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Median = 50th Percentile 

Median (M or C; or ]_): 
§ The Sample Median (M) of a set of n measurements is 

the middle value (or midpoint, 50th percentile) when 
the measurements are ordered from smallest to 
largest. 

§ If n is an odd number, there is a unique middle value 
and it is the median (i.e., the (n+1)/2-st ordered value). 

§ If n is an even number, there are two middle values 
and the median is defined as their average. 

Example: 6.4 7.8 8.1 9.2 10.5 

M = 8.1 

What is the average and median of the data set: 1, 2, 3, 4, 5? 

"1 = 

M = 

What is the average and median of the data set: 1, 2, 3, 4, 100? 

"1 = 

M = 
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Statistics that Measure the Variation or Dispersion of the 
Distribution of Data 

Sample Variance (s2): 

)=∑9?@(89:8̅45 = 
> 

≈ D5 (EFEGHIJKFL MINKILOP) 
A:B 

Sample Standard Deviation (s): 

V (xT − x1)5 
TWB s = R

∑ 
≈ D (EFEGHIJKFL 4JILYINY YPMKIJKFL) 

n − 1 

‘s’ estimates variability in same unit of measure as the 
observations and the mean 

Range (or R): R = Largest value minus the smallest value 

= maximum value – minimum value 

Example: 6.3, 2.4, 3.1, 3.1, 5.8, 2.7, 8.1 
R = 8.1 – 2.4 = 5.7 

Notice the range depends on the maximum and minimum of the 
observed sample, therefore, it is more useful for representing 
variation in small data sets.  
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Coefficient of Variation (CV) 

Is a scaled measure of dispersion, which is the standard 
deviation, divided by the mean (often multiplied by one 
hundred to represent percent). 

c`a% = × 100 
8̅ 

Helpful when comparing dispersion statistics across sets of 
data with varying scales of measure and means, e.g., 
product types, etc. 

This is the same as the relative standard deviation (RSD or 
%RSD); sometimes only positive values are considered 
(i.e., using the absolute value of the mean in the formula). 
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Control Charts without Subgrouping 

“X-Individual and Moving Range” Control Chart (or “ImR”) 

X-Individual Control Chart Formula: 

11111)e`f = "1 + 2.66 × (^g
11111)f`f = "1 − 2.66 × (^g 

Moving Range Control Chart Formula: 

11111)e`fhi = 3.267 × (^g 

where, (^g11111) = “average moving range” 
A∑ ^g\\W5 11111 =^g 
L − 1 

with each moving range (mR)i=|xi - xi-1| for 2 neighboring 
observations . 
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Control Charts with Subgrouping 

X-bar and Range Control Charts (or X-Bar and R) 

§ Organizing measurements data into subgroups often to help 
manage data streams. 

§ Each subgroup should be selected from some small space, time, 
or product to assure relatively homogeneous conditions within 
the subgroup – idea of “RATIONAL SUBGROUP” 

§ Emphasis is on minimizing the variation within the subgroups. 

X-Bar Control Chart Formula: 

Upper Control Limit (X-bar):  e`f8 = "j + k5 × g1̅ 

Lower Control Limit (X-bar):  f`f8 = "j − k5 × g1̅ 

Where: "j = grand average of subgroup averages 
g1 = average of the subgroup ranges 

Range Control Chart Formula: 

Upper Control Limit (Range): e`fi = lm × g1 
Lower Control Limit (Range): f`fi = ln × g1 

Constants associated with X-bar and Range Control Charts 
Subgroup Size n A2 D3 D4 

2 1.880 -- 3.267 
3 1.023 -- 2.574 
4 0.729 -- 2.282 
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5 0.577 -- 2.114 
6 0.483 -- 2.004 
7 0.419 0.076 1.924 
8 0.373 0.136 1.864 
9 0.337 0.184 1.816 

10 0.308 0.223 1.777 

The constants are used to standardize distributions under the 
assumption of normally distributed individual values, i.e., that the 
sample standard deviation is a biased statistic for estimating the 

population standard deviation 

IMPORTANT 
"Rational Subgrouping Rules-of-Thumb" 

§ Keep parallel operations in separate subgroups. 

§ A subgroup should not include data from a different lot 
or of a different nature. 

§ Each subgroup must be logically homogeneous, i.e., 
data within the subgroups must be collected under 
essentially the same conditions. 
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Other Control Charts with Subgrouping 

X-bar and s Charts: 

Control Limit Formula for XBar and s Control Charts: 

Upper Control Limit (XBar): e`f8 = "j + kn × 4̅̅ 

Lower Control Limit (XBar): f`f8̅ = "j − kn × 4̅ 

where, "j = grand average of subgroup averages 
4̅ = average of the subgroup standard deviations 

Upper Control Limit (Std): e`fc = om × 4̅ 
Lower Control Limit (Std): f`fc = on × 4̅ 

"Constants associated with X-bar and s Control Charts" 

n=subgroup size A3 B3 B4 

2 2.659 -- 3.267 

3 1.954 -- 2.568 
4 1.628 -- 2.266 
5 1.427 -- 2.089 
6 1.287 0.030 1.970 
7 1.182 0.118 1.882 

8 1.099 0.185 1.815 
9 1.032 0.239 1.761 
10 0.975 0.284 1.716 
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Control Charts for Attribute Data 
Data Based on Counts 

Concept of Area of opportunity during sampling: 

§ Background against which the count must be interpreted. 

§ Before any two counts may be directly compared they must 
have equal Areas of Opportunity. Examples include looking at 
number of nonworking electrical drills out of every 1000 

produced or number of cores without sufficient penetration 
per 20 cores tested. 

§ If the Areas of Opportunity are not equal, then the counts must 
be turned into rates before they may be meaningfully 

compared. 

§ When the total n (total sample number) is known: 

"np chart" control limits 

Upper Control Limit (np chart): 
e`fAp = L × E̅ + 3qL × E̅ × (1 − E̅) 

Lower Control Limit (np chart): 
f`fAp = L × E̅ − 3qL × E̅ × (1 − E̅) 

Average Proportion Nonconforming: 

E̅ = JFJIH LG^rPN LFLOFLsFN^KLt KL rI4PHKLP 4I^EHP4 
JFJIH LG^rPN KJP^4 PZI^KLPY KL rI4PHKLP 4I^EHP4 

Center Line: `fAp = L × E̅ 
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"p chart" control limits (when n varies per sample) 

Upper Control Limit (p chart): 

E̅ × (1 − E̅)
e`fp = E̅ + 3 × R 

L\ 

Lower Control Limit (p chart): 

E̅ × (1 − E̅)
f`fp = E̅ − 3 × R 

L\ 

Average Proportion Nonconforming: 

Eu = JFJIH LG^rPN Fs LFLOFLsFN^KLt KL rI4PHKLP 4I^EHP4 
JFJIH LG^rPN KJP^4 PZI^KLPY KL rI4PHKLP 4I^EHP4 

Center Line: `fp = E̅ 

Nonconforming product:  E\ = v\⁄L\ for sample i 
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Charts for Nonconformities 
(Can only count defects, impossible to count ‘non-defects’) 

Formula for "c chart" control limits 

Upper Control Limit (c chart): 

e`fx = O̅ + 3 × √O̅ 

Lower Control Limit (c chart): 

f`fx = O̅ − 3 × √O̅ 

Average Count per Sample: 

O̅ = tFJIH OFGLJ Fs LFLOFLsFN^KJKP4 KL rI4PHKLP 4I^EHP4 
LG^rPN Fs rI4PHKLP 4I^EHP4 

Center Line: 

`fx = O̅ 
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"u chart" control limits 

Upper Control Limit (u chart): 

G1
e`fz = G1 + 3R

I\ 

Lower Control Limit (u chart): 

G1
f`fz = G1 − 3R

I\ 

Average Rate of Nonconformities per Unit Area: 

{|{}~ x|zA{ �|Ä {ÅÇ É}cÇ~\AÇ c}hp~Çc Gu = 
{|{}~ }ÄÇ} |� |pp|Ä{zA\{Ñ \A É}cÇ~\AÇ c}hp~Çc 

Center Line:   `fx = G1 
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Draft – Not for Distribution 

Developing an ‘Individuals’ and ‘Moving Range’ 
Control Chart in Excel 

1. In a new Worksheet Tab > Copy your data to Column A > create the 

following headers in columns B through G: 

2. In cell B3 > calculate the moving range of cells A3 and A2 > type: =ABS(A3-
A2) and hit Enter key, you will have 0.1 in cell B3. Highlight cell B3 > grab 

the small square in bottom right corner of cell and drag down to the end of 
data (B21) 

Drag Down 
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3. Now let’s calculate the ‘averages’ for the data and its ‘moving range’ > 

type in word Average in cells A22 and B22 > in cell A23 type 
=AVERAGE(A2:A21) then hit the Enter key 

Grab the small square in bottom right corner of cell A23 and drag it one 

cell to the right to B23, this will give you the average of the moving 

ranges 

You should get these following statistics: 

4. Now let’s copy/paste these corresponding averages in columns C and D 

(Note we will need to ‘LOCK’ the cells in place) 
a. Type in cell C2 =$A$23 and hit Enter key (or type in =A23 and hit the 

F4 key on your keyboard); this locks cell A23 in cell C2 for future use 

b. Do the same for cell F2 =$B$23 (or type in =B23 and hit the F4 key on 
your keyboard) 

c. Highlight cell C2 and drag it down to C21 

d. Highlight cell F2 and drag it down to F21 
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You should have the following: 

5. Let’s calculate the Control Limits for the ‘Individuals Chart’ 

a. In cell D2, type =$A$23-2.66*$B$23 

b. In cell E2, type =$A$23+2.66*$B$23 

c. Highlight cells D2 & E2 and drag down to cells D21 & E21 

You should have the following: 
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6. Let’s calculate the Control Limit for the ‘Moving Range’ Chart 

a. In cell G2, type =3.268*$B$23 

b. Highlight cell G2 and drag down to G21 

You should have the following: 

7. Now, let’s make the Control Charts > Highlight cells A1:A21 > hold the ‘Ctrl’ 
key down and highlight cells C1:E21 (it should be highlighted in blue, see 

below) 
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8. Now, from the Main Menu (top of Excel) > click on ‘Insert tab’ > then click 

on the ‘Line’ Icon > click on ‘Line with Markers’ 

\ 

You will get the following chart: 

7.2 

7.4 

7.6 

7.8 

8 

8.2 

8.4 

8.6 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

CT Ratio 

Average 

LCL 

UCL 

9. You can now customize your chart any way you would like: 
a. Right click on the data points to customize your chart 
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This is a possible chart: 

10.Develop the ‘Moving Range’ chart for practice 
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Save your Workbook: 
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Developing a Control Chart in Minitab 18 
Moisture Example 

1. Start Minitab software 

2. Type in your data in Column 1 and change the column header to 
“Moisture”; you can also copy and paste from Excel or open directly 
from an Excel file or .csv (comma delimited) file 
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3. Click “Stat” from the main menu bar > click > “Control Chart” > 
“Variables Chart for Individuals” > click > “I-MR” (for Individuals and 
Moving Range Charts). Note: if you want just one chart, click on 
“Individuals” or “Moving Range” 

4. Click on “Moisture” > and the “Select Button” to add this variable to the 
one that you would like control charted > click “OK” 
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You will get the following “Individuals and Moving Range Charts” from 
Minitab 

Note: to access the “Options” features of the control charts, click on 
>”Tools” in the main menu bar > you will get the “Options – General” 
windows to pop up 
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Expand the “Control Charts and Quality Tools”  > Click on “Tests” 

58 



       
          

      

 

 

  

To copy paste your graph into Microsoft “Word” or Apple “Pages” editors > 
right click on the control chart image > Copy Graph > go to Word or Pages 
and > go “Edit Paste” or “Ctrl-V” and it will paste graph in document file 
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Developing a Control Chart in JMP 14 

1. Start JMP. 
2. Click > “Analyze” > “Quality and Process” >”Control Chart” 

3. Select type of control chart; for the sake of example, we will select “IR” 
chart in JMP which is the “X-Individual and Moving Range Chart” 
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4. You will be prompted to open a file containing your data 

5. For example we will directly enter data from an example. Go to JMP 
Home Window > Click > “File” > “New” > “Data Table” 
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Type in Your Data in Column 1 (Note: you can double-click on column 
header and you will get the “column properties window” > change column 
name to “Moisture” 
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6. Click on “Analyze” > “Quality and Process” > “Control Chart” > “IR” 

7. Click > “Moisture” > click on “Process Button” > “Moisture” will be 
added as the variable to be control charted > click “OK” 

You will get the following X-Individual and moving Range Control Charts in JMP 
(next page) 
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Many statistical-feature options are available to you in JMP under the “red arrow 
pulldown” for the “Control Chart” and many charting display features are 
available to you under the “Individual Measurement of Moisture” 

To copy paste your graph into Microsoft “Word” or Apple “Pages” editors > 
right click on “green right triangle” > “Edit” > “Select” > the graphs will turn 
blue > hold down “Ctrl-C” from your keyboard > go to your Word document 
> right click “edit-paste” or “Ctrl-V” and it will paste graph in document file 
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APPENDIX B – Capability Indices 

Indices or Assessing Short-Term Capability 

1. Cp Index 

$%& − &%& 
!" = -6 × ( ,⁄./ ) 

-

-,⁄./ is an unbiased estimator of 2 for small samples sizes, i.e., ,3⁄./ ≈ 5 

Recall Control Charting use of ,⁄./ 

Subgroup size d2 

2 1.128 
3 1.693 
4 2.059 
5 2.326 
6 2.534 
7 2.704 
8 2.847 
9 2.970 

10 3.078 

2. Cpk Index 

-
!"6 = min : , C

X USL − X - − LSL 

3 × (R⁄d/) 3 × (R⁄d/) 

If the actual average is equal to the midpoint or target of the specification 
range then Cp = Cpk 

3. Cpm Index (“Taguchi Index”) 

$%& − &%& 
=!"D 
6E(F3 − G)/ + (,3⁄./)/ 

where, T = target,  F3 = process average,  ,3⁄./= process variance 

The relationship of Cpm centers around Taguchi’s championed approach of reducing 
variation from the target value as the guiding principle to quality improvement 
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Indices for Assessing Long-Term Capability 

4. Process Performance Indices – (Pp) 

JKLMLKL PQ
I = = " N×O RQ 

(Uses standard deviation to estimate long-term variation) 

X 

s = T
∑WYZ(xW − x3)/ 

n − 1 

(Only valid for large n ~ n > 100) 

Pp Total product outside two-sided specification limits 
0.5 13.36% 

0.67 4.55% 
1.00 0.3% 
1.33 64 ppm 
1.63 1 ppm 
2.00 0 

5. Ppk Index 

F3 − &%& $%& − F3 
I"6 = \]^]\_\ : , C

3 × 5 3 × 5 

If the actual average is equal to the midpoint or target of the specification 
range then Pp = Ppk 

6. Ppm Index (“Taguchi Index”) 

$%& − &%& 
=I"D 
6 × E(F3 − G)/ + 5/ 

where, T = target,  F3 = process average,  s2 = process variance 
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Example Capability Analysis 

Given the following data of 18 samples of thickness, estimate the Process 
Performance and Capability Indices 

Subgroup Thickness 
1 0.407 
2 0.405 
3 0.405 
4 0.405 
5 0.395 
6 0.395 
7 0.402 
8 0.396 
9 0.393 

10 0.397 
11 0.399 
12 0.395 
13 0.400 
14 0.404 
15 0.404 
16 0.408 
17 0.407 
18 0.400 

`̅= .401  s = .0049 33333= .0035 \, 

USL: 0.405" LSL: 0.395" Target: 0.400" 

See Calculations on next page 

Note: there is not enough data in this example for a long-term 
capability analysis, calculations are just for illustrative purposes 
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JKLMLKL .fZgM.hig .ZjZ !" = = = = 0.537 
⁄ ⁄N×(b3 cd) N×(.ZZhg j.j/k) .ZjkN/ 

333[F3 − &%&] [$%& − F] 
!"6 = \]^ : , C

3 × (,3⁄./) 3 × (,3⁄./) 

[. 401 − .395] [.405 − .401 
= \]^ q , x

. 0035 . 0035 
3 × ( 3 × v 1.128) 1.128w 

= \]^[0.645 , 0.430] = 0.430 

(If interest is only on the lower specification, then Cpk=Cpl=0.645.) 

.fZg M .hig 
!"D = = 0.511 

yN×z(.fZjM.fZZ)d{(
.||}~ 
�.�dÄ

)dÅ 
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JKLMLKL .fZgM.hig .ZjZ 
I = = = = 0.34 " N×O N×(.ZZfi) .Z/i 

333[F3 − &%&] [$%& − F] 
I"6 = \]^ : , C

3 × (5) 3 × (5) 

[. 401 − .395] [.405 − .401 
= \]^ : , C

3 × (.0049) 3 × (. 0049) 

= \]^[0.408 , 0.272] = 0.272 

.fZg M .hig .ZjZ 
I"D = = = 0.333 

vN×E(.fZjM.fZZ)d{(.ZZfi)dw .ZhZ 

71 





 
 
 

           
 

The University of Tennessee is an EEO/AA/Title VI/Title IX/Section 504/ADA/ADEA institution 
in the provision of its education and employment programs and services. All qualifed applicants 
will receive equal consideration for employment and admission without regard to race, color, 
national origin, religion, sex, pregnancy, marital status, sexual orientation, gender identity, 
age, physical or mental disability, genetic information, veteran status, and parental status. The 
university name and its indicia within are trademarks of the University of Tennessee. 



31 25 19 13 7 1 

1.7 

1.6 

1.5 

1.4 

1.3 

1.2 

1.1 

1.0 

0.9 

Observ 

Re
te
nt
io
n 

2 

1.7 

1.6 

1.5 

1.4 

1.3 

1.2 

1.1 

1.0 

0.9 

Re
te

 t
io
n 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

n
1.7 

1.6 

1.5 

1.4 

1.3 

1.2 

1.1 

1.0 

0.9 

Re
te
nt
io
n 


	Structure Bookmarks
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	ú
	ú
	ú
	ú
	ú
	ú
	ú
	ú
	ú
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§
	§




